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This chapter describes the tools for drawing and editing objects. You
can draw objects anywhere on the page, even overlapping other
objects, but not across page boundaries. There are three types of
objects: frames, lines and ruler guidelines.

Frames are the basic building blocks in Ovation Pro. They are used to
hold the text and pictures that appear on the page and are normally
rectangular (but may be any closed shape).

Lines are normally straight or curved open paths, but may be any shape
(open or closed). Even if line paths are closed, they cannot contain text
or graphics. Typically, Lines are used to add additional graphics to the
page and for this purpose are better than frames because they use less
memory.

Ruler guidelines are used to help align objects on the page.
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8.1 Drawing frames

Frames irDvation Pro may be rectangular,
elliptical or irregular. In the latter case they may
be constructed from straight and curved line
segments. To draw a frame, left click on the
Frame tool and on the required shape from the
toolbox(fig 8.1).

Normally after drawing a frame or line, the Select

tool is automatically re-selected ready for text
entry. If you wish to draw a number of frames in
succession, choose the Frame tool by right
clicking, whereupon it will remain selected until
another tool is chosen.

An empty frame can contain either text or a
picture. If you wish to put a picture in a text

CHAPTER 8

Rectangular Frames

Move the crosshair to where you want one corner
of the rectangle to be, then left click and drag to
the opposite corner. Finally release the button
complete the operatiqfig. 8.2).

To draw a perfect square, hold down Shift while
drawing the rectangle (or use grid lock):

Menucw>Viewe>Grid Ctrl+Shift+G

Elliptical or Circular Frames

Ellipses are arranged to fit within a rectangular
area. Move the crosshair pointer to the centre of
the area then left click and drag to the required
size. Finally release the button to complete the
operation(fig. 8.3).

frame, you must delete all the text first. Similarly, 10 draw a perfect circle, hold down Shift while
if you want to put text in picture frame, you must drawing the ellipse (or use grid lock).
delete the picture first. To delete a picture select it

first by double clicking on it and then delete it
using the menu

Menu>Edit=>Delete picture Ctrl+K
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Fig. 8.1 - The toolbox.
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Fig. 8.4 - A straight- sided Fig. 8.5 - A curved-sided
irregular frame. irregular frame.
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Irregular Frames 8.2 Drawing lines

Choose Straight Line Segment or Curved Line  The Line tool in allows you to draw rectangles,
Segment from the toolbox. Left click where you ellipses, straight line@ig. 8.7) and curved lines
want the line to start, then move to the endpoint (fig. 8.8). You can draw single lines or sequences
and left click again. You can keep adding line  of connected lines. By default lines sequences a
segments to the path by moving to the endpoint adpen path, but can be closgid. 8.9 & 8.10)

each new line and left clicking. Alternatively click using an option in Path Edit Modsee 8.11).
and drag to each new endpoint, to allow auto-

scrolling at the edge of the window. You cannot
go beyond the page boundaries.

To draw a line, choose both the Line tool and the
required shape from the toolb(hg. 8.6). The
method of drawing lines is identical to that

At any time you can change between straight ancdescribed on the previous page for frames.
curved lines by choosing the required type from

the toolbox. To draw perfectly horizontal or
vertical lines, hold down Shift to constrain pointer
movement to the horizontal or vertical.

Remember that objects drawn with the line
tool cannot contain text or pictures.

Left double-click or right click to finish the path.
When drawing frames, the path is closed
automatically(figs. 8.4 & 8.5).

The shape of irregular frames can be edited in
Path Edit Moddsee 8.11).
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Fig. 8.7 - A straight line. Fig. 8.9 - An open path
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= Fig. 8.8 - A curved line. Fig. 8.10 - A closed path

Fig. 8.6 - The toolbox. line.
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8.3 Text Overflow and Linking Frames  Linking Frames

Once you have drawn a frame, you may type or To link two frames, select the Link tool from the
import text into it(see 3.1 & 3.3). If you type past toolbox(fig. 8.11a). Now click in the first frame
the bottom of the frame or import a story that is and drag the pointer to the second frame. During
too big, theoverflow flag will be displayed in the this operation, the pointer will change to a link
bottom right corner of the fran{éig. 8.12). In this  Symbol. After linking, the overflow flag will

situation, the overflowed text will not be visible  disappear from the first frame, but may be
and cannot be edited. displayed in the second frame if there is still not

enough space for the entire text st@rg. 8.13). If
you wish you can then link the second frame to a
third frame. You can link any number of frames

1. Delete some of the text to make space for thetogether in this way, even if they are on different
overflowed text. pages.

There are a number of things you can do to
remove the overflow flag:

2. Make the frame big enough to display all of Editing Text in Linked Frames

the text. Once frames are linked, text will flow automa-
3. Link the overflowed frame to another empty tically between them, and may be edited as
frame, so that the text will automatically flow normal. Caret movement will work correctly
into the second frame. between the frames, and you may select text
across them by clicking or dragging in the usual
way.

A =
TheIrrrech anical

typewriter, which
originated in the USA
about a century ago,
mrepresented the first majorg
«— Link tool advance over pen or
pencil. Its two principal
advantages were that a
competent typist could
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Fig. 8.12 - Frame with overflow flag.
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The mechanical write much faster with a
typewriter, which t sewriter than with pen
_ originated in the USA or pencil and that the
Fig. 8.11a - The toolbox. about a century ago, writing produced was
represented the first major consistent and clearly
advance over pen or legible. It was not
| Unkame — Delete link| pencil. Its tmpprincipal sfrprising. then, that the
| 1.90 advantages were that a typewriter heralded an
competent typist could ‘office revolution” in
Fig. 8.11b - The info palette having selected

the Link Tool Fig. 8.13 - Two linked frames with link shown.
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Linking Frames on Master pages.

Frames on the Master pages can be linked. As
well as the usual type of linking there is another

kind called ‘auto-linking’. This means that when To create this type of document, open the maste
the text in a master frame overflows in the pages and draw the labels as required. Now use
document, it will flow into the same frame on the the Link tool to link all of the labels in the order
next page i.e. a page will be automatically createghat you wish text to flow through them. Link the
with new frames linked to those on the preceding|ast label back to the first label. This link will be
page. shown in green, indicating that it is an auto-link
Often this feature is used with a chain of linked and will generate a new page when it overflows.
frames, where the last frame in the chain is auto- Close the master pages, and save the document
linked to the first frame in the chain. When the  a template.

last frame overflows, a new page is inserted and You can now type in the labels. Note that since v
the text flows into the first frame on the new pagegre using linked frames, you can use Ctrl Return

a new page of labels is inserted. Each label on t
master page is linked to the next label, and the ¢
label on the master page is linked to the first.

To create an auto-link, use the Link tool in the
usual way, but drag back onto the first frame in
the linked chair{fig. 8.14). In the case of a single
frame, drag back onto that frar(feg. 8.15).

An 'auto-link' is shown in green when the Link
tool is selected.

It is possible to have more than one auto-link
chain in a chapter.

to start a new label.

If you wish to import data e.g. names and addres
from a file, the data needs to be formatted
correctly first. Each field should be separated by
Line Feed (0Ox0A) or Carriage Return (Ox0D) or
both and each record by a Form Feed (0x0C). If
your data is in CSV format, then you will need to
convert your file before it is imported.

Name<0A>

To delete an auto-link, choose the Link tool, click ayqr ess 1<0A>
over the link so that it is selected i.e. shown in red.pqqr ess 2<0A>
Now press Delete or click the 'Delete link' button  pgst code<0C>

on the info palette.
A typical use of auto-linking is a template

document for labels. The idea is to draw the label

Name<0A>
Addr ess 1<0A>
LI Is also possible to use mail merge to solve this

on the master pages so that as each page is fiIIecP,rOblem(See 12.5).
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Fig.8.14 - Autolink: text flows from frame 1 to 2, then to 3
and to 4 and finally to frame 1 on following page.

Fig.8.15 - Auto-linking column 1 results in overflowing

text appearing on next page in column 1. Frame 1
overflows to frame 2, then to frame 1 on following page.
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Show Flow Special Notes

When you choose the Link tool, arrows are drawrrl he following points should be considered when
in the document indicating where text flows linking frames:

(fig. 8.13). 1. You cannot link to or from the Main frame,

Changing a Link

If you link from a frame that already has an 2

outward link, the original link is removed and text
flows according to the new link.

Unlinking Frames

To unlink frames, choose the Link tool so that you
can see the arrows that show text flow. To remove
a link, left click on the appropriate arrow, so that
it is highlighted i.e. shown in bladkg. 8.16).
Now press Delete to remove the link. Or click on
the Delete box on the info paleftey. 8.11b).

An auto-link will be shown in red when selected. 5

In the case of a chain of linked frames with an
auto-link the auto-link must be removed before
you can remove or change the other links. 6

Removing a link has the effect of removing the
text from the linked frame (and any subsequently
linked frames) and joining it back to the end of the
previous frame. This will cause the previous
frame to overflow, but no text will be lost.

Frame Break

You can force the caret to the start of the next
linked frame by pressing Ctrl Return, or by
choosing

Menu>Miscr>Insertm>New page

The break character may also be deleted, causing
text that follows to flow back into the previous
frame.

since this is already linked.
You cannot link picture frames.

3. If a frame contains text, it can only be linked

to an empty frame that doesn’t already have an
inward link or to the first frame of a chain of
linked frames as long as these linked frames
are empty.

4. If a frame is empty, it can be linked to any text

frame that doesn't already have an outward
link or to the first frame of the chain of linked
frames.

. You cannot delete linked frames. But a page

with linked frames can be deleted if all linked
frames are within that page only.

. You cannot cut or copy linked frames to the

clipboard, or copy linked frames using drag
and drop.

The mechanical write much faster with a
typewriter, which writer than with pen
originated in the USA r pencil and that the
about a century ago, writing produced was
represented the first major consistent and clearly
advance over pen or legible. It was not
pencil. Its two principal surprising, then, that the
advantages were that a typewriter heralded an
competent typist could ‘office revolution” in

Fig. 8.16 - Two linked frames with highlighted arrow.
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8.4 Drawing Aids Object Snap
There are a number of facilities available to help When drawing, moving or resizing objects, the
you draw and manipulate objects. edges of the objects snap into alignment with the

edges of other objects on the same page. Top

Cancelling _an Operation . . _ edges snap to top edges, bottom edges to bottor
Most operations concerned with manipulating edges et¢fig. 8.19).

objects can be cancelled by pressing Esc at any
time. So if you are in the middle of drawing a
frame, pressing Esc will cancel the operation.

Object snap may be disabled Preferences
(see 15.13), and is automatically disabled if grid

_ lock is enabled.
Auto Scrolling Grid
ri

The document window will automatically scroll if ) ) )
you drag close to its edges. The speed of scrollin§f OPJect grid lock is enablefsee 7.4), and an
is determined by how close the pointer is to the OPJECt IS drawn or resized, its edges will snap to

window edge; the closer it is, the faster it scrolls. the grid. If an object is moved, it will jump in
steps of the grid spacing.

If grid lock is enabled, thBenu=>Object=>Snap

to grid option will snap the top left corner of the
selected object to the nearest grid point. The siz
of the object is not altered.

Nudging the Pointer

When drawing, moving and resizing objects you
may position the pointer more accurately by
pressing the cursor keys to ‘nudge’ it one pixel in
the required direction. In this case Object snap
(see next paragraph) is overruled.

& =5 a1 & =5 £l
& =5 £l
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Fig. 8.17 - The selected frame is dragged in the direction of the arrow so that the left and
bottom edges snap to the larger frame. The right edge of the selected frame is then
dragged to the right until it snaps to the right edge of the larger frame.
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Ruler Guidelines
Menur>Views>Options=>Rulers  Ctrl+R

When rulers are enabléske 7.3), you can draw
your own vertical or horizontal guidelines across
the page. Edges of object will snap to these
guidelines when dragged close to them.

To draw a vertical guideline, left click on the
horizontal ruler at the required position.
Alternatively, left click then drag the guideline to
the required position. To draw a horizontal
guideline, do the same, but on the vertical ruler.

To move a guideline, move the pointer over the
guideline, so that the pointer changes to the
guideline tool(fig. 8.18). Now drag the guideline
to the required position. You can also drag a
number of selected guidelines in a single
operation.

To select guidelines, left click over the first one,
then Ctrl left click over other guidelines to add
them to the selection. Selected guidelines are
shown in red.

¥ Document! dpd *

I Tt

File Edit %iew Text Style Object Page Misc Applets Help
O s|s| | o]
B0 a0 1

CHAPTER 8

To move a selected guideline to an exact position,
chooseMenu=>Object>Modify and enter a value
in the dialogue box displaydtig. 8.19).

To delete a guideline drag it to the extreme edge
of the page. Alternatively, to delete selected
guidelines choosEdit=>Delete

To delete all vertical guidelines, Citrl left click on
the horizontal ruler. To delete all horizontal
guidelines Ctrl left click on the vertical ruler.

Guidelines are normally drawn over the top of all
frames, but an option on

Ctrl+Shift+P

allows them to be drawn behind instead

(see 15.13). Snap to ruler guidelines may be
disabled orMisc=>Preferenceq(see 15.13), and is
automatically disabled if grid lock is enabled.

Menuw>Misce>Preferences
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Fig. 8.18 - Document with vertical and horizontal ruler guidelines.

Fig. 8.19 - Modify guideline.
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8.5 Selecting objects Another way of selecting all the objects in an are

Before you can make changes to an object you is to construct a select box around the area by
must select it. Ensure that the Select tool is activd10lding down Ctrl Shift and pressing the left
(fig. 8.20) then left click over the object. This mouse button at one corner of the area to be

selects the object and deselects any other objectS€lected and dragging the box to the opposite
corner. Release the button when all the objects t

When an object is selected, it is enclosed in a redyg gelected are wholly within the select box; the
‘bounding box’ with 8 blue ‘*handles’ located objects will then be selected.

around its edges. The bounding box is a _ .

rectangular guideline that completely encloses thdf e object you want to select is obscured by
object(fig. 8.21 & 8.22). A handle is a small another object, hold down Ctrl Shift and double-
square which can be dragged to resize the objectc/iCk Over the top object to select the object
beneath. You may keep doing this to select
progressively deeper objects until you eventually
return to the top object.

In addition to frames and lines, you may also
select ruler guidelines. When selected they are

shown in red, but do not have handles.
If you want to permanently group a number of

You can select more than one object by holding objects, us®bject=>Group or Ctrl+Shift+K
down Control and left clicking each additional (see 9.11).

object. Control left clicking on an object that is
already selected causes it to be deselected.

Select tool

TR
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2|10 OO

4 = 1
Fig. 8.21 - An active Fig. 8.22 - An active elliptical
rectangular frame with eight frame with eight handles for

Fig. 8.20 - The Select tool. handles for resizing. resizing.
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8.6 Moving Objects Drag and Drop

To move an object, first ensure the Select tool is YOU can move or copy objects using the drag and
selected. Then left click over the object and keep drop facility. Unlike the normal move operation

it pressed and completely still until the Move  described above, you can drag and drop objects to
pointer appearéig. 8.23). Now drag the object to any page in the same document or in a different
its destination (which may be anywhere on the ~document.

same page) and release the button. If you hold  To drag and drop selected objects, hold down Alt

down Ctrl, you may drag the object immediately then drag them to the required position.
with the right button, without holding the button

down until the Move pointer appears. If you drag and drop within the same document,

objects aremoved; if you drag and drop to another
If you have a number of objects selected, movingdocument, objects amepied.

one of them will move the entire selection. You
can move a mixed selection of frames, lines and
ruler guidelines if you wish.

If you hold down Shift Alt while dragging, the
above operations are transposed. So, if you drag
and drop within the same document, objects are

To constrain movement to the vertical or copied; if you drag and drop to another document,

horizontal, hold down Shift while dragging. objects arenoved.

You can position objects precisely using the info |f you start a drag operation and wish to cancel it,

palette or théVlodify dialogue boxsee9.1). press Esc.

Using the Info Palette Please note that you cannot drag and drop master
X andY on the info palettéfig 8.24) are the objects or linked frames. But you can move linked

coordinates of the top left corner of the selected frames within a chapter.

object or group. Coordinates are measured from For drag and drop of selected tese 3.8.
the top left corner of the pagé.andY may be

modified to change the position of the object.

Press Return after modifying the values to update

the document.

If there is a selection of objects,andY refer to
the first object selected. In this casXindY are
modified, the first object is moved to the position
specified and the rest are moved proportionally.

01 01

X'
| Text frame X|2{Jmm |W|4{Jmm | | Trinity ﬂl 12p ﬂ
o O o |l 1 Y[2omm |H|emm | [N B|/|U|R1]2] E =

Fig. 8.23 - The Fig. 8.24 - The info palette gives the position of the selected object. You can reposition it
Move tool moves by changing the X and Y values.
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8.7 Resizing Objects Using the Info Palette

To change the shape or size of an object move th& andH on the info palettéfig. 8.26) are the
pointer over one of the 8 handles so thatthe ~ Wwidth and height of the selected object or group.
Resize pointer appeaffig. 8.25). Now press the W and H can be modified to change the size of
left mouse button and drag the mouse until the object. Press Return after modifying the values t
object is the size and shape that you want. Thereupdate the document.

are two types of handles: If there is a selection of object8] andH refer to
» Corner handles will resize the object both the first object selected. In this cas®fandH
horizontally and vertically. are modified, the first object is resized as specifit

» Centre handles will make the object either and the rest are resized proportionally.

wider or longer. X andY on the info palette refer to the distance
from the top left corner of the page to the top left
corner of the object frame. By changing these
values you can reposition the object frame.

If you hold down Ctrl while dragging, the original
shape (aspect ratio) of the object will be
maintained. If you hold down Shift, the object
bounding box shape will be constrained to a Resizing Picture Frames

square. If you resize a picture frame using the right mous

If you have a number of objects selected, resizing?uuo_n' th? picture is re5|zeq too. Th|_s only
one of them will resize the rest proportionally. unctions in both X and Y directions if Aspect

) . . ) ) lock has not been selected. This can be set in
You can resize objects precisely using the info

palette or th©bjectr>Modify dialogue box oF7 Menur>Picturer>Modify picture F6
(see 9.2). The size®V andH mentioned on the If aspect lock has been set the picture will be
info palette refer to the first object selected. resized according to the vertical size of the frame
o O o

0 m

T
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v

Fig. 8.25 - Move the pointer over a handle
and drag the resize tool to resize the object.

| Text frame X|2{Jmm |W|4{Jmm || Trinity ﬂl 12pt ﬂ
| 1.1 Y[omm |H[omm | [N B|7|UIR| ]| 2] FE &&=

Fig. 8.26 - The info palette gives the size of the selected object. You can resize it by
changing the W and H values and move it by changing the X and Y values.
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8.8 Rotating Objects Using the Info Palette

You can rotate text frames, picture frames and When the Rotate tool is chosen, the info palette
lines. To rotate an object choose the Rotate tool Provides a number of options concerned with
on the toolboxfig. 8.27) then left click and drag ~ rotating objectgfig. 8.28).

on any part of the object until it is at the desired A is the angle of rotation of the selected object or
angle(fig. 8.24). You may select a number of group. The angle of rotation is in degrees and is
objects either before or after choosing the Rotateapplied anti-clockwise. You may type in a new
tool, and rotate them all by dragging on any objecfalue followed by Return to rotate the object to

in the selection. the desired angle. Alternatively click on the up

The centre of rotation for the object or selection igand down icons to increase or decrease the angle.

indicated by a small crosshair which is initially at |f there is a selection of objedtsrefers to the
the centre of the object or selection, but may be first object selected. In this caseAifis changed,

dragged to another position. Please note that if  the first object is rotated as specified and the rest
you choose the rotate tool when there is no are rotated incrementally.

selected object, the crosshair will not appear until

you select one or more objects. Clicking on the 3 x 3 grid will position the

_ _ crosshair at the same relative position on the
Note that the Picture frame info palette does not selected object or selection. The 9 points relate to

show the angle of rotation of the frame but the  the centre, the fours corners and the centres of the
angle of rotation of the picture within the frame  four sides.

fig. 10.9). - .

(fig ) If Crosshair is selected, objects are rotated about
the crosshair, otherwise they are rotated about
their centres.
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Fig. 8.24 - Use the Rotate tool to rotate

|:| the object around the crosshair.
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Y [ Roate A @ —“‘-,:Il:lljpcmshair o | 9 [ -180°| -s0° |

& | 1.98 wintnl 45° | 1as° | -135°| -a5° |
Fig. 8.27 - The toolbox. Fig. 8.28 - When the Rotate tool is chosen, the info palette provides options to set the

angle of rotation and alter the position of the centre of rotation.
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8.9 Editing Objects using the Edit Menu Paste frame/line/selection Ctrl+Vv
Menu=Edit=.......... Pasteinserts the object or objects that are on the

This section describes the options on the Edit gggi&gﬁ;ﬁgggﬁ;ﬁié\gtfr:ecnhgosggrs 0
menu (fig. 8.29) concerned with objects. Some of bp

these options use the clipbodfid. 8.30) which th;sttgg sznt dcfgptirligfk\’vhere the object is to be
can be viewed using the Clipboard option on the P ’ '
View menu(see 2.2). An object can be pasted into a@yation Pro

. document, not just the one from which it was cut
The optionClear, Cut, Copy andDeleteapply or copied. After pasting, the clipboard contents

to selected objects provided that no text or picture .
. . ) remain unchanged.
is selected, otherwise they will apply to the text or

picture. This option is only available if the clipboard
contains an object or selection of objects.

Clear
Clear deselects all selected objects. Delete frame/line/guideline/selection
Select All Cirl+A This option deletes the selected object or objects.

Select allselects all objects on the current page. Undo / Redo (.:trlJ’Z [ Ctrl+Y
This is only possible if there is no active frame, Undo cancels the last operation performed,

otherwise it selects all the text in the active framerestoring your work to its previous staRedo

) ) cancels the last undo operation performed.
Cut framel/line/selection Ctrl+X P P

Cut deletes selected objects, and places them on! N€Undo andRedooptions when applied to
the clipboard, overwriting the previous contents. objects are identical to those described previously

) ) for text (see 3.4).
Copy framel/line/selection Ctrl+C
Copy copies the selected objects onto the
clipboard, overwriting the previous contents.
Undo Caret left  Cirl+Z
Bedo Caret left  Chrl+y
Cut Group ]+
=EfEyem L % Clipboard I[=] E3
Easte clipboard  Cirl+/
Delete Group Crl -+,
Embed alject
Selectall Ctrl+A Fig. 8.29 - The Editmanu.
Clear
Eind... Crl+F
Find next F3

Fig. 8.29 - The Edit menu. Fig. 8.30 - The clipboard containing a text frame.
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8.10 Embedding Objects
Menu=>EditcoEmbed object
Normally in Ovation Pro objects are anchored to

the page, buEditroEmbed object allows you to
embed an object or group into a text story such

that the object moves with its associated text when

the text reflows.

How to Embed an Object

First draw the object anywhere on the page and
Cut or Copy the object so that it is placed on the
Clipboard. Now position the caret at the required
insertion point in the texfig. 8.31), and choose
Embed object.

The embedded object is aligned with the text's

baseline and behaves just like a large character

which moves with its surrounding text when

editing causes text reflow. The text after the caret
is shifted to the right to make space for the object,

and the line of text is shifted down to
accommodate its heigffig. 8.32).

I =
The mechanical typewriter, which

originated in the USA about a century ago,
represented the first major advance over
pen  or ncil.  Its two principal
advantages| were that a competent typist
could write much faster with a typewriter
than with pen or pencil and that the
mwriting  produced was consistent  andp
clearly legible. It was not surprising, then,
that the typewriter heralded an ‘office
revolution’ in which typewriter
manufacturers made fortunes. Typing
became part of the school curriculum.
Despite its  many advantages, the
mechanical typewriter suffered one major
. = |

&l

Fig. 8.31 - A text frame with the caret positioned
ready for embedding an object.

CHAPTER 8

Important Points

Embed object is only available if the

clipboard contains an object or group of
objects. If the clipboard contains a selection of
objects that are ungrouped, only the first object
in the selection will be embedded.

You cannot ungroup an embedded group.

You can resize an embedded object as you
would a normal object, but you cannot move it
except by moving the text in which it is
embedded.

A text overflow will occur if you try to embed
an object into a frame that is too small to
contain it.

After embedding, the clipboard contents
remain unchanged.

The mechanical typewriter, which
originated in the USA about a century ago,
represented the first major advance over

pen or pencil. Ms twa  principal

advantagesy = pwere that a
competent typist could write much faster
with a typewriter than with pen or pencil
and that the writing produced was
consistent and clearly legible. It was not
surprising, then, that the typewriter

heralded an ‘office revolution’ in which

Fig. 8.32 - An embedded frame is aligned to the
text baseline. The text is shifted to the right and
the line moved down to make space for the object.
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Modifying an Embedded Object * The bottom of an embedded object is aligned

Menus>Objecte.. .. with the text's baseline, but you can shift it up
o and down vertically usiny.Shift on the

* Ifthe embedded object is a frame, all the Modify text dialogue box. All other options on

normal operations can be applied to the text or  his dialogue box are not applicable.

picture contents of the frame. _ . .
* Relative leading (i.e. that specified as a

* From theObject->Modify dialogue box oF7 percentage) is calculated from the size of the
(see 9.2) you can apply all options exceptfor eyt in the line and not from the size of the
X, Y andLock. embedded object.

* From theObjectr> Text flow dialogue box you Embedding Pictures Directly

can only apphstandoff You can drag a picture directly from disc into a

* Border andShapecan be applied, but all text story. A picture frame is then automatically
other options on th@bject menu are not embedded at the pointer position, and the picture
applicable. placed in it.

* You can select an embedded object just like
normal text andCut, Copy, PasteandDelete
it using options on thEdit menu.

* An embedded object can be placed in a
paragraph on its own by ensuring there is a
Return character directly before and after it
(fig. 8.33).

» Options on théormat dialogue box such as
Indent, Alignment, Spacebefore and
Spaceafter can be applied to a paragraph that
contains an embedded objetbs can also be
applied.

The mechanical typewriter, which
originated in the USA about a century ago,
represented the first major advance over
pen or pencil. s two principal
advantages o o

. = |
were that a competent typist could write
much faster with a typewriter than with
pen or pencil and that the writing
produced was consistent and clearly
legible. It was not surprising, then, that the

Fig. 8.33 - Embedded frame in a separate
paragraph with Centre alignment.
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8.11 Path Edit Mode If you select the end point of a curved segment,
Menur>ObjecteShape Cirl+H the control point for the Bezier curve IS sh(_)wn in
. ' ' orange and may be dragged to reposition it
The shape of objects drawn using straight and  (fig. 8.35). If you hold down Shift while you drag
curved line segments, can be edited in Path Edit g control point, the corresponding control point in

Mode. the next curve is also moved to keep the angle of
You cannot edit the shape of rectangles or  join constant.

ellipses without changing them to polygons

first usingObjecte>Shape(see 9.9). To edit another path, left click over it. If the object

_ _ you want to edit is obscured by another object,
To edit a path, choose the Path Edit Mode tool omolding down Alt and double-clicking over the top
the toolbox(fig. 8.34) and left click on the path to object will select the one underneath. You can

be edited. This is not necessary if an objectis  keep doing this to select progressively deeper
selected before entering this mode. objects.

The end points of each segment are shown in blug you find that editing paths is too slow because
and may be dragged to reposition them (they will surrounding text is continually being redrawn, you
snap to the grid if grid lock is enabled). You can can disable the redraws using an option on
constrain movement to horizontal or vertical by . . ,

holding down Shift while dragging. When moving Menur>Misce» Choicess Viewss.... _
a point you may use the cursor keys to nudge theDeselect 'Instant updates on path e(lite 15.6).

pointer in any direction. When you have finished editing your object, leave
Left click over an end point to select the line Path edit mode by choosing the Select tool on the
segment. Left click whilst holding down Control toolbox.

on a point to add or remove a line segmentto or  please note that in Path Edit Mode most of the

from the selection. Selected end points and line usual Ovation Pro operations are not available.
segments are displayed in red. If you have a

number of end points selected, moving one of
them will move the entire selection.

Path Edit Mode tool

8O

=
|

| I

Control points

N\

] Selected
end point

) LI

Fig. 8.35 - An irregular object in path edit mode with

I2|<|(

an endpoint selected. The two control points may be
Fig. 8.34 - The toolbox. dragged to change the angle of join.
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Path Edit Options

In Path Edit Mode, the info palette provides a
number of options concerned with editing the
selected patffig. 8.36). All of the options may be
applied to a single selected segment or to a
selection of segments.

The writable iconX andY are the coordinates of
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Make horizontal moves the selected end point
either up or down to make the line segment
horizontal (relative to the object rotation).

Make vertical moves the selected end point either
left or right to make the line segment vertical
(relative to the object rotation).

Add point adds a new segment into the selected

the selected end point. Coordinates are measuregegment, of the same type as the selected segment

from the ruler origin (normally the top left corner
of the page). These values may be modified to
change the position of the point. If there is a
selection of pointsX andY refer to first end point
selected. In this case XfandY are modified, the
first end point is moved to the position specified
and the rest are moved incrementally.

Change to straight linechanges the selected
curved line segment or move segment into a
straight line.

Change to curvechanges the selected straight
line segment or move segment to a curved line.

Delete segmenteletes the selected segment.

Flatten path straightens the join between two
curved lines or a straight line and a curved line, so
that the tangent is continuous at that point.

Open/close pathturns a closed path into an open
one, or an open path into a closed one.

Snap to grid aligns the selected end point to the
grid. The grid or grid lock must be enabled for this
option to work.

Change to movechanges the selected straight line

segment or curved line segment to a move
segment i.e. an invisible line.

Change to move Make horizontal
Change to curve Make vertical
Change to straight line \ / /Choose curve

| Path ecit mode X| | | — 1 | =
e P AN

Add point / / \
Delete segment Snap to grid

Flatten path
Fig. 8.36 - The info palette in Path Edit Mode

Open/close path
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Editing the Inset and Standoff Curves Editing the Inset Curve

The description above explains how to edit the To edit the Inset curve, click on the object you
shape of objects constructed using straight and wish to edit and then toggle toose curve
curved line segments. However, you may also ediiutton on the info palette until you are in the Inset
the ‘curves’ which repel text inside and outside a mode.

frame. This facility only applies to frames, and nofrpg |nset curve is positioned around the inside of
lines which are always transparent and do not  h6 frame and repels the text flowing in the frame.
repel text. You cannot edit the Inset or Standoff By default it is the same shape as the frame, but
curves for rectangles or ellipses without Changingpositioned 1mm in from the edge of the frame
them to polygons first using tt@bject>Shape 1y g 37). The default inset distance is specified
option(see 9.9). Cl+H 51 theModify dialogue boxsee 9.1). F7
Clicking onChoosecurve on the info palette
(fig. 8.36) allows you to toggle through the
following three modes:

The frame outline is drawn in grey with the Inset
curve drawn in grey with the end points in blue.
You can now edit the Inset curve using the same
F Default mode: this allows you to edit operations described on the previous pages

the shape of the object. (fig. 8.38).
If you wish to reset the Inset curve to its original
shape and position, reset the Inset value on the
Modify dialogue box to 1mm.

Inset mode: this allows you to edit
i the Inset curve.

mmmememne Standoff mode: this allows you to
- edit the Standoff curve.

Both Inset and Standoff curves are attached to the
frame shape and are moved and resized when the
frame is moved and resized.

]
q’he mechanical  typewriter,  which q’he L
originated in the USA about a century ago, mechanical typewriter, which

represented the first major advance over
pen or pencil. Its two principal advantages
were that a competent typist could write
much faster with a typewriter than with pen
or pencil and that the writing produced was
consistent and clearly legible. It was not
surprising, then, that the typewriter
heralded an ‘office revolution’ in which
typewriter manufacturers made fortunes.
Typing became part of the school
curriculum. Despite its many advantages,
the mechanical typewriter suffered one
major drawback. As soon as the typist hit
=

Fig. 8.37 - The outer line is the frame guideline
and the inner line is the default Inset curve.

originated in the USA about a century
ago, represented the first major
advance over pen or pencil. Its two
principal advantages were that a
competent typist could write much
faster with a typewriter than with pen
or pencil and that the writing
produced was consistent and clearly
legible. It was not surprising, then,
that the typewriter heralded an ‘office
revolution” in which  typewriter
manufacturers made u
fortun

|

Fig. 8.38 - The Inset curve has been edited
causing the text to flow inside the new shape.
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Editing the Standoff Curve Editing Picture Runaround
Menuw>Object>Text flow  Ctrl+Shift+T ThePicture option on thebject=>Text flow
To edit the Standoff curve, click on the object yC,udialogue box automatically modifies the default

wish to edit and then toggle tiEhoosecurve Standoff curve so that it follows the shape of the
button on the info palette until you are in the picture instead of the frame. Using the facilities
Standoff mode. described in this chapter you may edit the

Standoff curve to fine-tune the runaround shape to

The Standoff curve is the positioned around the your exact requirements.

outside of the frame and repels text flowing
around the outside of the frame. By default it is
the same shape as the frame, but positioned 1mm
out from the edge of the fran(ieg. 8.39). The

default standoff distance is specified on the
Objectr> Text flow dialogue boxsee 9.7).

The frame outline is drawn in grey with the
Standoff curve drawn in grey with the end points
in blue. You can now edit the Standoff curve
using the same operations described on the
previous pagefig. 8.40).

If you wish to reset the Standoff curve to its
original shape and position, reset Standoff
value on thél'ext flow dialogue box to 1mm.

The mechanical typewriter, which The mechanical typewriter, which
Griginatw:l in the USA about a ceqiury ago, originated in the USAg_about a century
represe nted the ago, represented the first major
first major advance over pen or
advance over pen pencil. Its t w o
o r pencil. principal advantag
Its two principal es were ghat a
advanta ges were compete nt typist
that a compete could write
nt typist could m u c h faster
write much with 4 typewriter
faster with a than with & pen or pencil
typewrity gr than and thae he writing
with pen or pencil and that the writing produced was consistent and clearly
produced was consistent and clearly legible. It was not surprising, then, that the
Fig. 8.39 - The inner line is the frame guideline Fig. 8.40 - The Standoff curve has been edited

and the outer line is the default Standoff curve. causing the text to flow around the new shape.
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Notes:



